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Abstract 
 
The purpose of the development is to present an option for reducing costs in the delivery of ornamental plants to nurseries. 
The nursery is located in the town of Parvomai and is located in the eastern part of the Plovdiv region, in the Thracian 
plain, at about 134 meters above sea level. Different varieties of flowers are produced in it – petunias, violets, verbena, 
tagetis, sakezets and other species. The nursery stocks and delivers goods to 5 small sites in the surrounding area To 
achieve the goal, the following tasks must be solved: to characterize the used vehicles; to optimize transport costs by 
solving a transport task under certain conditions. By using MS Excel Solver, proposed algorithm for describing a 
transport task and its subsequent solution, significantly speeds up the calculation procedures and helps to reduce costs 
when making deliveries. 
 
Key words: optimization model, transport task, Solver. 
 
INTRODUCTION  
 
Decorative plants are one of the main details of 
the interior of the house or the landscape of the 
garden. The beginning of the nursery production 
of decorative planting materials in our country is 
connected with the construction of the parks at 
the residences Evksinograd - Varna, Krichim 
and Vrana - Sofia. The creation of green systems 
in cities and other settlements, the landscaping 
of various objects (enterprises, schools, 
hospitals, etc.), knowledge of the stages in the 
production and cultivation of ornamental trees 
and shrubs in nurseries, planting in the green 
areas and their successful further cultivation are 
the main tasks for specialists in this field. 
The cultivation of ornamental plants falls under 
floriculture, which is a major branch of 
horticulture. They are seen not so much for 
practical purposes as for decoration and 
comfort. Decorative indoor plants perfect house 
design. The assortment of plants is large. 
Ornamental plants have quite exotic species. A 
nursery is a place where plants are propagated 
and grown to the desired size. Some nurseries 
specialize in certain areas. Nurseries can also 
specialize in one type of plant. 
Some produce stock seasonally, ready in the 
spring for export to colder regions where 
breeding could not begin as early, or to regions 
where seasonal pests prevent early season 

cultivation. (Dobrevska G. et al., 2015). 
Nurseries grow plants outdoors, in container 
fields, tunnels and greenhouses. There should be 
a minimum time gap between removing the 
material from the nursery and planting in the 
desired location. To avoid exposure to the sun, 
the planting material should be removed from 
the nursery in the evening and planted the next 
day. 
The aim of the development is to load more sites 
with minimal fuel costs. To achieve it, the 
following task must be solved: to optimize 
transport costs by solving a transport task under 
certain conditions. Such an approach was 
developed in the publication (Dallev, 2021) to 
optimize the transport costs of fertilizing on a 
farmer's farm. Thus, we have already created a 
program for optimization problem solving. This 
approach was use in the research study of 
(Ivanova et al., 2018; Marinov, 2016; Atanasov 
et al., 2020; Blagoeva et al., 2021; Georgieva et 
al., 2019; Yordanova et al., 2020). 
 
MATERIALS AND METHODS  
 
The nursery is located in the town of Parvomai 
and is located in the eastern part of the Plovdiv 
region, in the Thracian plain, at about 134 
meters above sea level. The terrain is 
predominantly hilly and flat. The climate is 
transitional-continental with pronounced 
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temperature contrasts. The soils are chernozem 
(smolny, cinnamon-forest, meadow-alluvial). 
(Dobrevska et al., 2015). Different varieties of 
flowers are produced in it – petunias, violets, 
verbena, tagetis, sakezets and other species 
(Figure 1). 
The nursery supplies and delivers goods to 5 
small sites in the vicinity. The first site is located 
in the village of Gradina, the distance is 6 km 
from our base. The second object is located 
again in the village of Gradina, but it is at a 
distance of 8 km. Object 1 and object 2 are at a 
distance of 2 km from each other. Site three is 
located in the village of Byala Reka and is 10 km 
away from the nursery. Site four is located in the 
village of Dragoynovo and is 15 km away. The 
two sites are 5 km away from each other. The 
last site we charge is located in the village of 
Patriarch Evtimovo and is 20 km away from the 
nursery. 
From the calculations, it can be seen that the 
sites are not close to the nursery. 
The transport is carried out with two vehicles, 
each of which has an additional construction 
made of shelves in order to maximize the use of 
space and ensure a larger delivery of goods. We 
have the following equipment: 
Fiat Scudo 2005- 
Characteristics: Length - 4,805 m, Width -1,895 
m, Height -1,980 m 
Fuel consumption - urban 8.4/100 km, extra-
urban 6.8/100 km, combined - 7.2/100 km. 
Fuel type - diesel 
We load the sites with seedlings in trays, 
dimensions of the trays - 48 nests, length 52.5 
cm, width 37.5 cm. The number of boards in the 
Renault Master with the additional 3 shelves is: 
Width includes 55 pcs. boards, i.e. 55 x 3 = 165 
pcs. boards, there are 13 boards in length - 13 x 
3 = 39 pcs., the total capacity is 165 + 39 = 204 
pcs. boards. 
Which makes 204 pcs. boards with 48 nests, a 
total of 9792 plants. 
In order to keep the fuel costs to a minimum, we 
proposed to site 1 and site 2 to make their 
delivery of plants on the same day, the delivery 
is made by Renault Master due to the large 
requests (Monday and Wednesday). 
On Monday we deliver 72 boards for Site 1 and 
100 boards for Site 2. 

On Wednesday we deliver 90 boards to site 1 
and 110 boards to site 2. 
We deliver 17,856 plants per week. 
After that, we offered the same option to site 3 
and 4, with which their delivery takes place 
(Tuesday and Friday). 
Tuesday we deliver 50 boards to site 3 and 130 
boards to site 4. 
Friday we deliver 160 boards to site 3 and 43 
boards to site 4. 
A total of 9744 plants. Again, delivery is made 
by Renault Master. 
At sites 1, 2, 3 and 4, delivery is made with a 
Renault Master bus, due to its large size and the 
possibility of more goods. 
Object 5 - delivery is made (Monday and 
Thursday), due to the small amount of sales, 
delivery is made with Fiat Scudo. 
We deliver 18 boards on Monday and 25 boards 
on Thursday. 
In total for the two days we deliver 2064 plants. 
 

 
Figure 1. The nursery varieties of flowers 

 
Algorithm used for the transport problem 
solving via the instruments of MS Excel 
Solver (MS EXCEL 2010) 
 
One of the tools in MS Excel is a module for 
optimization task solving called Solver (Figure 
2). It can be found under the Data menu. It must 
be activated before its first use taking the 
following steps: 
• launch MS Excel; 
• select Options from the File menu; 
• the Excel Option dialog box appears; 
• click on the submenu Add-Ins (Additions) → 
Manage (Management) and select Excel Add-
ins (additions in Excel); 
• close the dialog box with OK. 
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Figure 2. Solver activation dialog box 

 
In this way, we now have the program for 
solving optimization tasks. 
The transport task is formulated as it follows: 
Consider the following task. At the points 

 (which we will call producers) is 
produced output in quantity, respectively а1, 
а2,…..аm. Points  (we will call them 
users) need the same output in quantities 
respectively b1, b2,……, bn. There is a balance 
between production and consumption i.e. 

.  

The transport costs per unit from point 
 to point  are cij. 

To devise up a plan for the procurement of 
points of production from the points 

, so that the needs of consumers are 
met, the goods of the producers to be disposed 
of and the total transport costs to be minimal. 
 
RESULTS AND DISCUSSIONS  
 
Assignment to optimize transportation costs for 
delivery to five sites: 
To carry out the delivery operation with two 
vehicles to the following sites (Figure 3): 
1. Site 1 - 162 boards at a distance of 6 km from 
the nursery; 
2. Site 2 - 210 boards at a distance of 8 km from 
the nursery; 
3. Site 3 - 210 boards at a distance of 10 km from 
the nursery; 

4. Site 4 - 173 boards at a distance of 15 km from 
the nursery; 
5. Site 5 - 43 boards at a distance of 20 km from 
the nursery. 
The data on the average fuel consumption 
during transport has been determined 
empirically - 0.244 L/km and the calculations 
are made at an average fuel price of BGN 3.25. 
 

 
Figure 3. The sites 

 
Task. To solve the following transport problem 
 

Bj 
Ai 

B1 B2 B3 B4 B5 ai 

A1 0.05  0.12 0.05 0 0.1 755 

A2 0.02 0 0 0.02 0 43 

bj 162 210 210 173 43 798 
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Solution. The transportation problem is closed 
because a balance between production and 
consumption is observed, i.e. 

�𝑎𝑎𝑎𝑎𝑖𝑖𝑖𝑖

2

𝑖𝑖𝑖𝑖𝑖𝑖

= �𝑏𝑏𝑏𝑏𝑗𝑗𝑗𝑗  

4

𝑗𝑗𝑗𝑗𝑖𝑖

= 798 

MS Excel (Solver) is used for solving the 
resulting closed (balanced) transport problem. 
Figure 4 presents a spreadsheet with the 
mathematical model of the specified task. 

 

 
Figure 4. Task model spreadsheet 

 
Completing the worksheet: 
1. In cells $D$3:$H$4 we enter the values of 
transport costs, in cells $I$3:$I$4 - the constants 
from matrix A(ai), and in cells $D$5:$H$5 - the 
constants from matrix B (bi). 
2. In cell $K$7, we enter the formula used for 
calculating the value of the objective function, 
i.e. = SUM PRODUCT(D3:H4; D109:H11). 
3. In the second table, in cell $C$11, formula = 
SUM (D10:D11) is entered and zero appears 
after clicking the mouse. 
And then it is copied to the remaining cells 
$D$12:$F$12. A null value also comes out. 
In the same way, a formula is entered for cell 
$I$10 and copied to cell $I$ 11.  
When composing the formula, one can use 
absolute addressing of the cells that contain the 
variables of the task (the $ sign is placed in front 
of the column name and/or row number). 
When solving large-scale problems, it is suitable 
to use the built-in function, SUMPRODUCT, 
which calculates the scalar product of two 
vectors of the same dimension. 
We enter the input data and activate the formula 
from the menu Data (Data) → Solver, after that 

We open an empty dialog box named Solver 
Parameters, which shows the formula for the 
value of the objective function (Figure 5). 
It is recommended that before calling Solver, the 
cell with the target function should be current - 
in this case, cell $K$7. 
With Equal To, select the radio button 
corresponding to the criteria of the model, in the 
specific task, select Min. 
The By Changing Cells box shows the entered 
cells, which contain the values of the problem`s 
variables. In the present task, these cells are 
$D$12:$H$12 on which the objective function 
is minimized. 
When we click on the Subject to the Constraints 
field, we use the buttons next to it in order to 
enter the restrictive conditions - in this case we 
can add, or change using the Change button and 
delete existing constraints using the Delete 
button. After the entry of the current limit is 
finished, we select the Add button if we must 
enter a new limit, or the OK button if the entry 
is completed.  
The Make Unconstrained Variables Non-
Negative option is checked. 
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Figure 5. "Solver Parameters" dialog box 

The other items in the dialog box are not 
recommended for a change. Finally, when we 
click the OK button, we return to the Solver 
Parameters dialog box. 

Figure 5 shows the Solver Parameters dialog 
box. The Solver button is selected from the 
Solver Parameters dialog box to solve the 
problem. The solution is presented in Figure 6. 

 
Figure 6. The spreadsheet and dialog box 

 
Solver Results 
The results obtained by the performed 
optimization are provided in the Solver Results 
dialog box. In the specific case, it is established 

that all restrictive conditions and conditions for 
optimality are satisfied regarding the given 
solution. Cells $D$10:$H$11 show the optimal 
solutions and an optimal plan is obtained. 
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We can save the found optimal solution in the 
Solver Results dialog box (clicking the Keep 
Solver Solution button) or we can restore the 
original worksheet (clicking the Restore 
Original Values radio button). 
It is possible to make a reference to the 
problem`s solution from this dialog box 
(Answer Report). 
Taking into account the proposed description, as 
well as the presented solution of a transport 
problem in MS Excel environment using the 
capabilities of the MS Excel Solver, we can 
conclude the following: 
The proposed algorithm is easily applicable 
regarding the description of a transport task and 
its subsequent solution using MS Excel Solver; 
Software applications use significantly quickens 
the calculation procedures; 
"Solver" add-on tool is established as a 
functional one as it can be used both, for 
transport-type problems, as well as for problems 
in other areas. 
The model of the transported problem is suitable 
for the correct and optimal solution of the 
problem under consideration. 
 
CONCLUSIONS 
 
The following conclusions can be drawn from 
the present research study: 
• The used algorithm proposed for describing a 
transport problem and its subsequent solution by 
means of software applications significantly 
accelerates the calculation procedures and is an 
easily applicable optimization method. 
• Thanks to the optimization, the transport costs 
for charging 5 objects have been minimized to 
BGN 42.94. 
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